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Strategic Triggers
The Trigger Toolkit option includes five different types of triggers, which are used to define
under what conditions an action should occur:
Alert
Button
Field Change
Record Save
Schedule
The Details tab is used to enter setup information about the trigger. The Conditions tab is
used to define the conditions under which the trigger is to be executed. The Actions tab is
used to define the actions to be taken once the trigger is executed. The Button trigger does not
have a Conditions tab because it is a button that is clicked to execute.
All tabs have a navigation pane on the left that allow you to choose what trigger to update.
Simply click on the trigger name to highlight that trigger and open it for editing.

Activating and Deactivating Triggers
For both schedule and alert triggers, there is an Active check box that allows you to specify
whether or not the schedule trigger is active. Select the check box to make the trigger active
or clear the check box to make the trigger inactive. When creating a trigger, this check box
defaults to selected.

Tool Bar
All triggers use the standard Tool Bar with an additional component, the Trigger Class
dropdown.

The Trigger Class dropdown is used to select the trigger class to be created or updated: User
or Internal. As the names describe, triggers can be user-defined or shipped with People-Trak
and used internally.

User versus Internal Triggers
All of the trigger types can be either user-defined or shipped with People-Trak and used
internally. The Trigger Class dropdown on the trigger Tool Bar allows you to select the
trigger class to be created or updated: User or Internal. The dropdown defaults to User, which
allows you to create or update your own user triggers.
You can view the Internal triggers by selecting Internal in the Trigger Class dropdown, but
the only update you can do is to set the trigger to inactive by clearing its Active check box.
You would typically want to do this if you want to modify the internal trigger for your own
use.

Workbook

Alert Trigger
Alert triggers are based on a date within a record. When the specified date meets a defined
condition and any additional defined conditions are met, the trigger is executed and its
associated actions are taken. Alert triggers are checked to see if their conditions are met when
logging into People-Trak, switching between modules and executing NightRun.
Note: The Check Alert Triggers check box in Enterprise Setup allows you to specify whether
or not you want NightRun to check alert triggers.
The Alert Triggers process uses a three-tab screen.

Details Tab
The Details tab is used to name the trigger, assign it to a category, and define the Last
Execution date

Conditions Tab
The Conditions tab is used to define the conditions by which the alert trigger will be
executed. The If Today’s Date Is field is composed of four separate fields that make up the
alert trigger formula: amount, period, operator, and date. The bottom part of the tab uses the
standard query grid.
Amount

The amount field is used to define how many days, months or years will be used in the
equation.

Period

The period field contains three options: Days, Months or Years.

Operator

The operator field allows you to set when the trigger will execute: Before, After, Before
Anniversary of and After Anniversary of. The Before/After variable will execute sometime
before/after the field variable. The Before Anniversary of/After Anniversary of variable will
execute sometime before/after the anniversary of the field variable every year.

Date

The date field is the fourth field in the Conditions formula. This field determines what date
field will be checked in every record. You may track any date field in People-Trak, such as
Birth Date, Next Exam Date, Hire Date, and Seniority Date.
In addition to the date field that is being checked, you can add further conditions using the
standard query grid.

Active Records
Only

The Active Records Only checkbox allows you to specify whether or not you want only
active records to be included in the alert trigger. Select the check box to only include active
records in the alert trigger. Clear the check box to include all records in the alert trigger.

Actions Tab
The Actions tab is used to define the actions to be taken once the trigger is executed.
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Button Trigger
Button triggers are executed by the click of a button. Unlike any other triggers, button
triggers require no conditions to be met. You need only set the action and place the button on
the screen of your choosing. For example, a button trigger can be used when you want to
replace the Emergency screen on the Personal screen with a custom screen. You can make a
button that will display your custom screen and insert it in place of the Emergency screen.
Now whenever you click this button, the trigger will execute and display your custom screen.
Picture, Hyperlink and Button objects on a custom screen can all use a button trigger. The
Button Triggers process uses a two-tab screen.

Details Tab
The Details tab is used to enter setup information about the trigger.
Trigger Name

The name of the button trigger.

Category

The category into which the button trigger is to be placed. This category can also be used to
secure button triggers. A table that contains all of the existing categories for the current
module supports this field. You can only select a valid entry from the table.

Button Caption

The button’s caption, which is the text that will be visible on the button when placed on a
screen.

Auto Execute

A check box that allows you to specify whether or not the button trigger should be auto
executed whenever the screen it is on is displayed. You might want to do this when the
button is being used to recalculate totals on a screen. Select the check box to have the button
trigger be executed when the screen it is on is displayed, or clear the check box to only have
the button trigger be executed when it is physically clicked. When creating a trigger, this
check box defaults to not selected.

Actions Tab
The Actions tab is used to define the actions to be taken once the trigger is executed
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Trigger Actions
The following is a list of all available trigger actions. The actions that are valid for a trigger
vary depending on the type of trigger being updated. See the Actions tab information for each
type of trigger for a listing of valid actions for that trigger.
For each action, the Detail:row button allows you to enter the detail for the action. When you
click the button, a screen unique to that action is displayed for detail to then be entered.
Assign Task
Display Message
Display Prompt
Display Screen
Execute Procedure
Execute Tool
Hyperlink
Insert Row
Run Document
Send Email
Send Message
Set Alarm
Update Derived
Update Field

Assign a task to a user
Display a message
Display message with Y/N prompt
Display a screen
Execute a procedure
Execute a People-Trak tool
Execute a hyperlink to the specified URL
Insert a row in a grid. Used before Update Field actions.
Run a report, letter, label, etc.
Send email
Send a message to a user
Set an alarm for a user
Update any derived fields on the current screen
Update a field for the current record

Assign Task
The Assign Task action assigns a task to any user, including yourself. There are eight
different types of tasks: activity, administration, create, document, edit, link, processing and
table. Once the trigger takes effect, the selected task will be sent to the specified user’s Inbox.
From the Inbox, the user can execute that task, which will run an activity, launch an
administrative action, create a new record, run a document, edit records, access a link , run a
process, or maintain a table.

Display Message
The Display Message action displays a message on the user’s screen. This can be an
informative message or a reminder. The entry that executed the trigger is allowed.

Display Prompt
The Display Prompt action displays a prompt with a specified message and then the question
“Do you wish to continue?”. If the user answers “Yes”, the rest of the actions defined for the
trigger will be executed. If the user answers “No”, the rest of the actions defined for the
trigger are skipped. This action can be used to allow the user to escape out of the sequence of
actions about to occur. For example, if a series of reports are about to be printed that would
take a long time to generate, the user might decide to generate the reports at a later time.

Display Screen
The Display Screen action displays a specified screen.

Execute Procedure
The Execute Procedure action executes code that is not included in standard People-Trak
features. This code can be written by you or People-Trak, depending on the feature.

4
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Procedure Type

Procedure Name

The type of procedure to execute.
Custom

Custom procedures created by People-Trak for specific customers.
The custom code is compiled into a DLL and installed and
registered in the People-Trak directory.

Database

Stored procedures in the ACTIVEDB database, which is used by
People-Trak. These may be created by People-Trak personnel (for
SQL or Access) or by members of your own IT staff (for SQL
only, because Access is password protected).

External

External procedures stored in EXE, VBS or BAT files.

Internal

Stored procedures already included in People-Trak.

The name of the procedure to execute. If the Procedure Type is:
Custom

Parameters

Enter the name of the custom procedure, if any have been created
for you by People-Trak.

Database

Enter the name of the procedure created in the ACTIVEDB
database.

External

Enter the name of the EXE, VBS or BAT file. This file must be
stored in the People-Trak root directory so it can be shared by all
users.

Internal

Enter the name of the internal procedure. This field is supported by
a popup that lists the internal procedures for the current module.

The parameters required by the procedure, separated by commas. You can enter literals or
People-Trak Field IDs.

Execute Tool
The Execute Tool action executes the specified People-Trak tool. This action is only
applicable for button triggers.

Hyperlink
The Hyperlink action executes a hyperlink to the specified URL. This action is only
applicable for button triggers.

Insert Row
The Insert Row action inserts a row in a grid and is required before Update Field actions that
require a new, blank row. Once the row is inserted, Update Field actions can then overwrite
that blank row with the necessary data.

Run Document
The Run Document action runs a specified document.
Document Name

The name of the document to run. This field is supported by the Select Document popup,
which in this specific use includes Audit Reports.
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Group Type

Auto-Destination

The group type to use to select what records to include in the report query. For Alert
Triggers, you have a choice of Current Record or Use Query. For Schedule Triggers, you
only have a choice of Use Query because no records are opened for that type of trigger. All
other triggers have all three options: Current Group, Current Record or Use Query. If an
Audit Report is selected, you only have a choice of Use Query because there are no records
involved in those types of reports.
Current Group

Current Group queries the whole group of the current record being
viewed. This is valuable when you would prefer the document to
include all records in a certain group as opposed to only the
current record or the whole database.

Current Record

Current Record queries only the current record that is being
viewed. This can be used when you want the user to view only his
information on the document instead of all other records.

Use Query

Use Query uses the query assigned to the document in the
Explorer.

The destination to which the document is to be sent.
Archive

Archives the document.

Email

Sends emails based on the document’s email breaks and/or email
distribution specified in the document’s properties. If the selected
document does not have an email break and does not have email
distribution specified in its properties, no action is taken.

Printer

Sends the document to the default printer. Alert and Schedule
triggers do not have this option because those types of triggers
might be executed via NightRun.

Viewer

Sends the document to the Document Viewer. Alert and Schedule
triggers do not have this option because those types of triggers
might be executed via NightRun.

Send Email
The Send Email action sends an email to the specified recipients. When you select this action,
the following screen is displayed. This is the standard Send Email screen used throughout
People-Trak.

Send Message
The Send Message action sends a message to the specified user’s Inbox.

Set Alarm
The Set Alarm action sets an alarm for yourself or another user for a specified date and time.
It functions just like using the Set Alarm tool.

Update Derived
The Update Derived action updates any derived fields on the current screen. A Details screen
is not necessary for this action.

Update Field
The Update Field action updates a field with a new value.
6
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Field Name

The name of the field that is to be updated when the trigger is executed. This field is
supported by the Select Field popup.

Row Modifier

For fields that are normally tracked on a grid, this is the row number on the grid where the
field is to be updated. The following values are valid:
Blank
1- 99
+

Top row
Row indicated
Bottom row

Note: The Select Row Modifier popup screen shows codes 1-10, but higher row numbers can
be manually entered as well. The Update Field action overwrites any existing data in the
specified row. If you require a blank row to be inserted before the overwrite, an Insert Row
action is required before the Update Field action(s). For example, if you want to update the
Company Property grid with a new row of Property Type and Issue Date, you would have an
Insert Row action inserting a row at the appropriate location followed by two Update Field
actions overwriting that same row in the appropriate fields.
New Value Type

The type of the new value. This field is supported by the Select Value Type popup.

New Value

If the New Value Type is Derived Field or Field, this is the field that contains the new value
and is supported by the associated popup. If the New Value Type is Value, this is the new
value that is to be inserted into the field.

Row Modifier

If the New Value Type is Field and the New Value field is one that is normally tracked on a
grid, this is the row number on the grid where the new value resides. Otherwise, this field is
not used.

Trigger Type/Trigger Action Matrix
The following is a matrix showing the trigger actions that are available for each type of
trigger. The Field Change trigger type can be used for validation or process purposes, so that
is so noted in the table.

Trigger Action
Assign Task
Disallow Entry
Display Message
Display Prompt
Display Screen
Execute Procedure
Execute Tool
Hyperlink
Insert Row
Run Document

Alert

Button

Field
Change
Process

X

X

X

Field
Change
Validation

Record
Save

Schedule

X

X

X

X

X

X

X
X

X
X
X
X

X

X
X
X
X
X
X

X

X

X

X

X

X
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Alert

Button

Field
Change
Process

Send Email
Send Message

X
X

X
X

Set Alarm
Update Derived
Update Field

X

X
X
X

Trigger Action
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Field
Change
Validation

Record
Save

Schedule

X
X

X
X

X
X

X
X
X

X

X
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This lesson introduces the concept of triggers by having you create a field change trigger,
define different conditions for when the trigger will be executed, and specify what actions
should occur when the trigger is executed.

Tutorials
Field Change Triggers: shows how to create a field change trigger, which is a good
representation of how triggers work.
More About Conditions: demonstrates how to create other conditions for your field change
trigger.
Use a Query Condition: shows how to add a query condition to your field change trigger.

Lesson 1

Tutorial 1.1 – Field Change Triggers
Field Change triggers are the most obvious triggers to demonstrate and will be the object of
our demonstrations in this lesson.
1. Start People-Trak by double-clicking on the People-Trak Trainee icon on your desktop
(or as instructed).
The Select Product Option screen is displayed.
2. The Position Control, Attendance, and Strategic Toolkit options should be the only
options that are toggled on. If they are not, select the Training button and then select the
Strategic Toolkit option.
3. Click OK.
The Login screen is displayed.
4. In the User ID field, enter DEMO.
5. In the Password field, enter DEMO.
The Organizer desktop is displayed with the Personnel Management module selected.
Let’s start by learning about Field Change triggers.
6. On the Tools menu, select Field Change Triggers.
The Field Change Triggers screen is displayed. The Field Change Triggers screen uses
three tabs to specify the details, conditions, and actions of each of your field change
triggers. A list of the current field change triggers, a Menu Bar, and a Tool Bar are
provided to enable you to fully manage your field change triggers.
On the right side of the Tool Bar, there is a Trigger Class dropdown that allows you to
choose to display User or Internal triggers. Internal triggers are provided with PeopleTrak; you can copy them or make them inactive, but you cannot edit them. User triggers
are created and edited by you, the user. We will see how to copy an internal trigger in a
later lesson.
Let’s get started and create a field change trigger.
7. On the File menu, select New Field Change Trigger or on the Tool Bar, click the New
Field Change Trigger button to start a new field change trigger.
A default name is assigned. The name is NEW-#, where “#” is the next available, unused
number.
8. Change the name of the trigger to City Change Trigger.
9. For the Category field, select Personal.
For field change triggers, the next field, Trigger Field, is very important. It determines the
field upon which the trigger is based. If this field not only changes, but changes to meet
the condition we are about to define, the trigger is executed and the specified actions will
be taken. But we are getting ahead of ourselves. Let’s select a field first.
10
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10. In the Trigger Field field, click the popup button to display a list of the fields in the
Personnel Management module. Select the City field.
We have now specified that our trigger condition will be based on a change of the
employee’s city of residence.
The next field, Row Modifier, is only used if the Trigger Field is a multi-row field. This
is the modifier that determines which row should have its changes monitored. Since the
City field is not multi-row, we will leave this field blank.
11. Leave the Row Modifier field blank.
The next field, Trigger Use, allows you to specify how this trigger is going to be used. It
can be used for validation or it can be used for processing purposes. The first trigger we
are going to create is a process trigger, so we will keep the field set to the default of
Process.
12. Keep the Trigger Use field set to Process.
Finally, the last field on the Details tab is the Active check box. This check box is
automatically selected when the trigger is first created. It means that this trigger will be
checked each time the City field is changed. If at some point you wish to deactivate the
trigger without deleting it, you can simply clear this check box. This is normally done
when a trigger that has been in production is being changed. While a trigger is being
changed and tested, you may not want the partially completed trigger to be executed. To
prevent this, deactivate the trigger while the trigger is being updated and reactivate the
trigger when you are ready to test it and use it.
13. For now, leave the Active check box selected.
14. Click the Conditions tab and we’ll set a condition for our field change trigger. In the If
New Value Is field, click the popup button to display a list of the operators.
This list contains operators that work just like the operators used in query functions
throughout People-Trak. The operator names may be slightly more verbose than those
you have seen before, but the functionality is the same.
15. Select the Equal to operator.
Once the operator is set, we must specify the corresponding value. For the City field we
are using in our example trigger, the value is going to be a valid city name. For another
field such as a salary amount, the value would be a specific salary amount. For a date, the
value would be a date.
When the cursor is positioned to this value field (there is no label), a popup button may
be displayed depending upon the field selected and the type of field. In our example, a
button is displayed that can be used to pick from a list of the valid cities that have been
defined.
16. In the value field, use the popup button to display a list of the cities and select the city
named Bonsall.
We now have a trigger condition that will cause the specified actions to be taken if the
City field is set to or changed to Bonsall. You can also use the standard query grid to add
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further conditions. We won’t be using the query grid in our example.
Before we can test our trigger, we need to define an action. Let’s do that now.
17. Click the Actions tab.
Field change triggers that are being used for processing can perform a number of actions.
We’ll learn about each of these in the coming lessons. For now, just follow along as we
create an action that can be used to test our trigger.
18. In the first row of the Action Type column, click the popup button to display a list of the
available action types. Select the Update Field action.
This action is used to force the contents of a field to a specific value. Because we are
creating a field change trigger, the update field will only be updated if the condition
defined in the trigger is met. Our trigger condition will be met if the city is Bonsall.
Bonsall happens to be in California, so we will cause the State field to be set to CA
whenever the City field is set to Bonsall.
19. When you selected the Update Field action, the cursor moved to the second row. Click
back in the first row and then click the Detail:1 button.
The Update Field screen is displayed.
20. In the Field Name field, click the popup button to display a list of the available fields.
Select the State field, which is the employee’s state. (Remember, there are also state
fields for dependents and emergency contacts.)
The Row Modifier field is used when a row in a grid is being updated. Since an
employee’s State is a single value and not in a grid, we can leave that field blank. We will
see how this field works in a later lesson.
21. Leave the Row Modifier field blank.
The New Value Type field is used to select what type of value you want to use for the
update.
22. In the New Value Type field, click the popup button.
As you can see, you can use a derived field, a regular field or a fixed value. We are going
to use a fixed value.
23. Select Value.
24. When the cursor is positioned to the New Value field, there will be a popup button that
you can use to display a list of the states that have been defined. Select CA for California.
The Row Modifier field is only used if you are updating a field with the contents of a
specific row in a grid. We will not be doing that in this example.
25. Leave the Row Modifier field blank.
26. Close the Update Field screen, saving your changes.
Our trigger is now complete. It’s time to try it.
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27. Close the Field Change Triggers screen.
28. Open Donald Stern’s record. Clear the City and the State fields on the Personal screen.
29. In the City field, select Vista.
Note that the State is not set to CA. That is because the trigger was not executed. The
trigger was indeed checked, but the condition of the trigger was not met. The condition
demands that the City be set to Bonsall.
30. In the City field, select Bonsall.
Now the condition is met and the State field is set to CA.
And that’s how all triggers work. There is an event such as a field change that sets a
trigger in motion. If the trigger condition defined in the trigger itself is met, the action (or
actions) defined in the trigger is executed. Now let’s do one more thing.
31. Click the Emergency button to display the Emergency Contacts screen. Clear the City
and the State fields for the first contact. Change the City to Bonsall.
What happens? Nothing. That is because we based our trigger on the City field for the
employee. If we wanted the same action to occur for the City field for either emergency
contact or for dependents, we would need to create separate field change triggers for
those fields.
32. Close Donald Stern’s record, without saving your changes.
33. Continue with the next tutorial.
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Tutorial 1.2 – More About Conditions
Let’s learn how to create other conditions for your field change trigger.
1. On the Tools menu, select Field Change Triggers and then select the City Change
Trigger we created in the last tutorial.
2. Change the Trigger Name to Birth Date Trigger, and change the Trigger Field to
Birth Date. Change the Trigger Use from Process to Validation.
3. On the Conditions tab, enter the following condition:
If New Value is

Greater than
TODAY

Note: You must select date variables using the Date Variable popup button to the right of
the Calendar popup button. Since this is a date field, you cannot type the text directly.
This will be true in the several places where dates or date variables can be entered.
This change will demonstrate a few features you have learned before. Our condition now
tests for a birth date that is set greater than the current date. Because we have used a Date
Substitution Variable, the condition will work correctly, without change, indefinitely.
With this change in field and condition, our action is hardly appropriate. We don’t want
to do anything but disallow this bogus entry, which makes the trigger’s use one of
validation. This means that we need to change the Trigger Use field from Process to
Validation.
4. Click the Actions tab.
Changing the Trigger Use field deletes any existing actions, so our previous action of
Update Field has been deleted. This is because there are different action types allowed
based on the Trigger Use setting.
5. In the first row of the Action Type column, click the popup button to display a list of the
available action types.
As you can see, there are only two valid action types available for a Validation field
change trigger: Disallow Entry and Execute Procedure.
6. Select Disallow Entry.
7. Click the Detail:1 button to display the action details for the first row (remember to click
back in the first row).
8. In the Message Text field, enter the following:
You cannot set a birth date in the future.
The Disallow Entry action will cause the invalid date that was entered to be discarded
after the message is cleared.
9. Close the Disallow Entry screen, saving your changes.
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10. Close the Field Change Triggers screen.
Now let’s try it out.
11. Open Donald Stern’s record. In the Birth Date field, change Donald’s birth date to a
date in the past.
Because the trigger condition was not met, our message is not displayed.
12. Now set Donald’s birth date to a date in the future.
This time our warning message is displayed because the condition was met. This is the
type of field change trigger that you can use to ensure that your users do not key
inappropriate information.
13. Click OK to close the message.
Note that his Birth Date is changed back to the previous entry.
14. Close Donald’s record, without saving the changes.
Now for a few more tricks.
We are going to adjust this trigger to change it from a validation trigger that prevents bad
data entry to a warning trigger that will help you to comply with governmental
regulations. To set our condition, we first need to create a custom date variable.
15. On the Setup menu, select Enterprise Setup. Click the Date Variables tab. For the
USER2-YEARS-BACK variable, in the Periods column, enter 16. When used, this date
variable will be converted to a date exactly 16 years ago today. Close the Enterprise
Setup screen, saving your changes.
16. On the Tools menu, select Field Change Triggers, and then select Birth Date Trigger.
17. Change the Trigger Use from Validation to Process.
18. On the Conditions tab, change the value field from the date variable TODAY to the date
variable USER2-YEARS-BACK, so the condition is now the following:
If New Value is

Greater than
USER2-YEARS-BACK

Note: On the Date Variable screen, you will need to select the Years category in the list
box on the left in order to see the years-based date variables.
19. Click the Actions tab and enter an Action Type of Display Message. Click back in the
first row and click the Detail:1 button. Enter the following message:
This employee is less than 16 years of age. Please obtain a work permit or other
appropriate documentation from his school or other authorities.
This trigger now checks the birth date to determine if the employee’s age is less than 16.
If so, you are reminded to obtain the necessary paperwork to legally employ this
individual.
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20. Close the Display Message screen, saving your changes. Close the Field Change
Triggers screen.
Now let’s test it.
21. Open Donald Stern’s record. We need to make Donald much younger. In the Birth Date
field, enter a date a few days before today’s date 16 years ago.
There should be no message because Donald is at least 16 years of age.
22. Now change Donald’s date of birth to a few days after today’s date 16 years ago. This
time, you will see the message and you can take appropriate action.
23. Close Donald Stern’s record, without saving your changes.
24. Continue with the next tutorial.
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Tutorial 1.3 – Use a Query Condition
Field change triggers are a very powerful feature. You can set a trigger (or triggers) on any
field in any module. And you can define a nearly infinite range of conditions to obtain the
results you desire. In addition to the condition specified for the trigger field, you can have a
query based on any fields in the module.
One thing that is unique to the query in this trigger grid is that to determine the value of a
field, the transaction log is first checked. If there is a pending transaction for the field in the
current session, that transaction value is used. If there is no transaction, the value in the
database is used. This allows you to query on the most recent value of the field.
Let’s add a query condition to a field change trigger.
1. On the Tools menu, select Field Change Triggers, and then select Birth Date Trigger.
Click the Conditions tab.
2. Enter the following query, which uses the standard query form:
Last Name
First Name

=
=

Stern
Verne

AND

Note that there is an AND between the two conditions, which means both conditions
must be met in order for the trigger to execute.
3. Close the Field Change Triggers screen, saving your changes.
4. Open Donald Stern’s record. In the Birth Date field, enter a different birth date but
make sure you keep Donald younger than 16 in order to meet the first condition.
The query checks to see if the last name is Stern and the first name is Verne. The
condition is not met. So, our first condition was met but not the second condition. Since
both conditions were not met, the trigger is not executed.
5. Change Donald’s First Name to Verne.
When you do so, there is no message because the field change trigger is on the Birth Date
field.
6. In the Birth Date field, enter a different birth date, keeping Donald younger than sweet
16.
This time, the query condition is met. Because both conditions are now met, the trigger is
executed and the action specified in the trigger (to display the employee age warning
message) occurs.
7. Change the Birth Date again. Because both conditions are met, the trigger is again
executed. Now change Donald’s First Name from Verne back to Donald. Then, change
the Birth Date again.
This time, both conditions are not met and the trigger is not executed.
8. Close Donald Stern’s record, without saving.
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9. On the Tools menu, select Field Change Triggers. Delete Birth Date Trigger. Close
the Field Change Triggers screen.
10. This concludes this tutorial and lesson.
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This lesson covers two alert and schedule trigger actions that are unique to the Strategic
Toolkit option: Update Field and Run Document. It also demonstrates how to use email to
run documents.

Tutorials
Update a Field: shows how to use an alert trigger to update a field.
Use Email to Run Documents: demonstrates how to use the Send Email action to send an
email and have documents run and attached to the email.
Run a Document in Another Way: shows how to use a schedule trigger to run a document.

Lesson 2

Tutorial 2.1 – Update a Field
In the Essential Tools training, you learned how to create basic alert and schedule triggers.
This lesson reviews alert and schedule trigger concepts by covering additional features
available for these triggers in the Strategic Toolkit.
Let’s begin by creating an alert trigger that uses the update field action, which is a feature
added in the Strategic Toolkit. Remember that alert triggers are used to take action based on
events that are approaching or have passed based on any date within a People-Trak module.
1. On the Tools menu, select Alert Triggers.
The Alert Triggers screen is displayed. The Alert Triggers screen uses three tabs to
specify the details, conditions, and actions of each of your alert triggers. A list of the
current alert triggers, a Menu Bar, and a Tool Bar are provided to enable you to fully
manage your alert triggers. Let’s get started and create an alert trigger.
2. On the File menu, select New Alert Trigger or on the Tool Bar, click the New Alert
Trigger button to start a new alert trigger.
A default name is assigned. The name is NEW-#, where “#” is the next available, unused
number.
3. Change the name of the trigger to 5-Year Anniversary Alert.
4. Set the Category to Status.
5. Leave the Active check box selected.
For alert triggers, the next field, Last Execution, is very important. When an alert trigger
is initially created, this date determines when the trigger will next execute. For example,
if you set the trigger to today, it will indicate that the trigger should first be checked
tomorrow. If you set the date to yesterday, the trigger will be checked today. Since we
want to test our trigger, we either need to set the date to yesterday or leave it blank. We’ll
set the date to yesterday for our demonstration.
6. In the Last Execution field, enter yesterday’s date.
Now we’ll set a condition for the alert trigger.
7. Click the Conditions tab.
Alert trigger conditions place a date from a record in an equation. The condition is made
up of four fields: the amount, the type of period (days, months, years), the operator, and
the field to compare. In our example, we want to reward employees after five years of
service with an additional 8 hours of vacation.
8. In the If Today’s Date Is field, set the amount field to 5. Set the period type to Years.
Select the After operator. Now, in the fourth field, select the Hire Date field. The
condition should now read as follows:
If Today’s Date is
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9. Select the Active Records Only check box to limit this alert to active records only.
10. On the Actions tab, click the popup button to display a list of the available actions.
You will see the list of actions available. The Strategic Toolkit adds four new actions that
were not available in base People-Trak: Execute Procedure, Insert Row, Run Document
and Update Field. We won’t demonstrate the Execute Procedure or Insert Row actions in
this lesson because you will learn about those actions in later lessons. We will learn about
the Run Document action later in this lesson. You learned about the Update Field in the
previous lesson, but in our example, we are going to show you a new twist.
11. Select Update Field and go into the Detail for that action.
In our training database, the current balance of vacation time for an employee is stored in
the Hours Available column of row 2 (vacation account) in the Attendance Accounts
grid. In your data, you will have fixed rows for each type of account. You would use the
appropriate row for your needs.
12. In the Field Name field, select Hours Available.
13. In the Row Modifier field, enter 2.
14. In the New Value Type field, select Derived Field.
We have created a derived field for you to use for this demonstration. It takes the value in
row 2 of Hours Available and adds 8 to that value.
15. In the New Value field, enter Additional 8 Hours of Vacation.
16. Close the Update Field screen, saving your changes.
You would normally send emails to notify both HR and the employee that this update had
occurred. For the sake of time, we will not add the email actions to do that.
17. Close the Alert Triggers screen.
Now, let’s try out our trigger. We will need to make someone’s hire date 5 years before
today’s date to get the trigger executed.
18. Open Julie Carrington’s record. On the Status screen, change her Hire Date to 5 years
before today’s date.
Let’s see what her current vacation time balance is.
19. Select the Attendance screen and write down the Current Balance amount for the
Vacation account in row 2.
20. Close Julie’s record, saving your changes.
Remember that Alert triggers are checked when logging into People-Trak, switching
between modules or executing NightRun. The first time the alert is checked each day, the
Last Execution field is set to the current date and that alert will not be executed again on
that date. When we created our sample alert, we set the Last Execution field to yesterday.
So, it will run the next time we log into People-Trak or change modules. Let’s change
modules.
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21. Switch to the Safety Management module and then switch back to the Personnel
Management module.
The trigger was executed. Let’s go confirm that fact.
22. Open Julie’s record. On the Attendance screen, check the Current Balance amount.
Julie should now have 8 more hours of vacation available.
In reality, you would also want to update attendance history to explain this increase. You
can easily do that with Insert Row and Update Field actions.
23. Close Julie’s record.
You can see how powerful the Update Field action can be when using derived fields. If
you need to update fields in People-Trak using a trigger, you have the tools to do so.
24. Continue with the next tutorial.
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Tutorial 2.2 – Use Email to Run Documents
This tutorial will demonstrate a powerful capability of the Send Email action to create and
send reports that are ready to print with a single click. This is something you could do with
base triggers, but it leads in nicely to the new Run Document feature, which we will
demonstrate in the following tutorial.
Our mission in this tutorial is to create a schedule trigger that emails a set of reports to the HR
Manager on a monthly basis. The first thing we need to do is create a cluster report that
includes the reports we want to send.
1. On the Documents menu, select Cluster Reports. Create a new cluster report and set the
Cluster Name to Monthly Cluster Report. Set the Explorer Category to General,
overriding the table if necessary. Set the Category to Personal. On the Documents tab,
add the following reports in the General category:
Alphabetic Employee List
Birthday List by Date
2. Close the Cluster Reports screen, saving your changes. Close the Explorer.
Now, we need to create the schedule trigger. Remember that schedule triggers are similar
to alert triggers but are based on a different type of condition.
3. On the Tools menu, select Schedule Triggers.
The Schedule Triggers screen is displayed and is very similar to the Alert Triggers screen
you just learned about. We can skip redundant details and get started.
4. On the File menu, select New Schedule Trigger or on the Tool Bar, click the New
Schedule Trigger button to create a new schedule trigger.
5. Change the name to My Scheduled Reports and set the Category to Personal.
6. Leave the Active check box selected.
The Last Execution field is updated when the trigger is executed. The Next Execution
field is updated according to the frequency you select for this trigger. We will leave these
fields blank so the trigger will execute today.
7. Click the Conditions tab.
Now we’ll set a condition for the schedule trigger. As you might recall, schedule triggers
are based on specified points in time. When that time is met, the trigger actions will be
executed. For example, you might wish to schedule a series of reports to be run each
month. Or you may wish to send an email to the benefits carrier with an attached report
every month.
The condition is made up of three fields. The first two fields set the frequency and the
start date for the schedule trigger. The third field, which is not always visible, indicates a
special value based on the frequency selected. For example, if you select a monthly
frequency, the third field will reflect the day of the month on which the trigger is to be
executed. For a weekly frequency, the third field will indicate the day of the week on
which the trigger is to be executed.
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We want to create a schedule trigger that will send an email each month, so we will
choose a frequency of Monthly and a Start Date of today’s date.
8. In the Frequency field, select Monthly.
The Start Date is defaulted to today’s date, and the Day of the Month field is displayed
with the current day of the month.
9. Leave the Start Date field set to today’s date.
10. Click the Actions tab.
11. Add a Send Email action and open the Detail for it.
We want to send the HR Manager a set of reports each month.
12. So, set the To Address Type to Position.
13. In the To field, click the popup button.
The Lookup Position screen is displayed.
14. Click Search and then select 1043 - Human Resource Manager.
The position number for the HR Manager is returned to the To field. The email address
for the employee currently in that position will be derived at the time the trigger is
executed, and the email will be sent to that address.
15. Click the Message tab.
We won’t be using an Email Definition in our example.
16. In the From Address Type field, select Address Book.
Your cursor is now in the From field.
17. Click the Address Book button that is now available.
The Email Source screen is displayed.
18. In the list of source types on the left, select HR User and then select Timothy Carpenter
(you as DEMO user) in the list of names on the right.
Timothy’s email address is returned to the From field.
19. Set the Subject to Reports are Ready.
20. In the Text field, enter the following:
There are reports in your email. These reports have been fully run and saved as
PDF documents. All you need to do is print them. Life is good.
21. Click the Attachments tab.
22. In the Attach Document field, click the popup button to display a list of the available
documents.
24
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The Select Document screen is displayed. As you can see, you can select any PeopleTrak document.
23. In the list of report types on the left, select Cluster Reports. In the list of categories on
the left, select General. Now, select the Monthly Cluster Report document you created.
Let’s assume these reports are confidential and need to be encrypted.
24. Select the Encrypt Document check box.
25. In the Group Type field, click the popup button.
Only the Use Query option is available because the Current Record and Current Group
options are not valid in a schedule trigger because no records are open at the time the
trigger is executed.
26. Click OK to select that option.
The attach document capability in email is a powerful feature. Unlike regular attachments
which are used to attach files, the attach document capability runs the specified
document, converts it to a PDF document, and then attaches the resultant PDF file, all
without operator intervention.
Because we selected a cluster report that contains multiple documents, we do not have to
make multiple emails (although we could). With just one email, we can run many reports,
place them into a single PDF document, and attach them to an email. This solves the
problems of time and convenience. If the schedule trigger runs at night, it can take as
long as it needs to generate all of the reports. When the reports are done, they are placed
in a single PDF and emailed to you. You can walk into your office in the morning, open
your email browser, print the PDF and have a whole set of monthly reports ready to read
before your coffee is cool enough to drink. That’s convenience!
After all that, we should test this thing.
27. Close the Send Email screen, saving your changes. Close the Schedule Triggers screen.
28. Switch to the Safety Management module and then switch back to the Personnel
Management module.
You will see a simulated email giving you the password for the attachment coming in a
subsequent email. The password was generated because you requested encryption.
29. Click OK to close the message.
Another simulated email is displayed. Note that the email has an attachment and that the
attachment is a PDF. In live production, both emails would have been sent directly to you
and the simulated emails would not have been shown. All you would have to do is open
the attached PDF using the given password and have access to all the reports
immediately.
30. Click OK to close the message.
In this example, we sent monthly reports to your email. Some of these reports are
probably for managers and other internal users and so you might need to distribute them
manually. Of course, if you think about it, you do not. You can create a whole stack of
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Send Email actions that create and send the appropriate reports to the appropriate people.
For example, if you have ten managers who each receive reports, you need only create
one schedule trigger with ten Send Email actions. If you use Cluster Reports, you can
send each manager their own private collection of reports using email without performing
any work on your own. Of course, we won’t broadcast that fact.
31. Continue with the next tutorial.
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Tutorial 2.3 – Run a Document in Another Way
In the last tutorial, we used a schedule trigger to send an email that effectively ran a
document, which was then attached to that email. In this tutorial, we will show how to use a
schedule trigger to run a document in yet another way. In fact, when we run this document, it
will send its own emails.
Our first step is to create the document we want to run using our trigger. We are going to save
some time and copy an existing report.
1. On the Documents menu, select Adhoc Reports.
2. In the General category, highlight the Birthday List by Department by Date report.
3. On the File menu, select Copy Adhoc Report.
A copy of the report is created and highlighted.
4. Open that newly created report.
We want to email each supervisor a list of their employees along with their birth dates.
Let’s change this report to do just that.
5. Change the name to Birthday List by Supervisor by Date.
6. On the Report Definition tab, replace the Department Name field with Supervisor
Email.
7. Clear the Repeat flag and set the Sort Type to Email.
8. Close the Adhoc Reports screen, saving your changes. Close the Explorer.
Now let’s use our monthly schedule trigger to run this document.
9. On the Tools menu, select Schedule Triggers and open the My Scheduled Reports
trigger.
10. Clear the Last Execution and Next Execution fields so our trigger will execute again
today.
11. On the Actions tab, replace the Send Email action with a Run Document action. Open
the Detail for that action.
The Run Document screen is displayed.
12. In the Document Name field, click the popup button.
The Select Document screen is displayed.
13. In the General category of Adhoc Reports, select our Birthday List by Supervisor by
Date report.
14. In the Group Type field, click the popup button.
Once again, the only option is Use Query.
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15. Select Use Query.
16. In the Auto-Destination field, click the popup button.
The Select Document Destination screen is displayed with two options: Archive and
Email. Archive allows you to run a document and send it to archive. Email allows you to
run the document and then email it. Other options available from other triggers are
Printer and Viewer. Those two options are not available from Alert and Schedule triggers
because those types of triggers might be executed via NightRun.
We are going to choose the Email option, which will only send an email if the document
has an email break or email distribution information in its properties. Our document has
an email break, so an email will indeed be sent.
17. Select Email.
18. Close the Run Document screen, saving your changes.
19. Close the Schedule Triggers screen.
Let’s execute the trigger.
20. Switch to the Safety Management module and then switch back to the Personnel
Management module.
You will see a simulated email that shows that our document has been run, generated as a
PDF file, and emailed to the first supervisor. As you learned in earlier training on Email
breaks, that supervisor only received that portion of the report that pertained to him.
21. Click OK to close that simulated email.
Another simulated email is shown that is identical to the first one, but for another
supervisor.
22. Click OK to close this and subsequent simulated emails.
The Run Document action can be used in all trigger types.
23. This concludes this tutorial and lesson.
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Contents
Tutorial 3.1 – A Simple Button Trigger
Tutorial 3.2 – Email a Document On Demand
Tutorial 3.3 – Populate Multiple Fields with a Single Click

This lesson covers how to create a variety of button triggers and then add those buttons to
custom screens.

Tutorials
A Simple Button Trigger: shows how to create a simple button trigger and then add that
button to a custom screen.
Email a Document on Demand: demonstrates how to create a button trigger that sends an
email to an employee with a special document attached.
Populate Multiple Fields with a Single Click: shows how to create a button trigger that
performs a series of Update Field actions.
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Tutorial 3.1 – A Simple Button Trigger
On to yet another type of trigger, the Button trigger.
1. On the Tools menu, select Button Triggers.
The Button Triggers screen is displayed and is similar to the other trigger screens you
have seen. The difference is that button triggers do not have a condition. They are
executed when you click on the button. Buttons are placed on custom screens using the
Button, Picture or Hyperlink objects in the Custom Screens process. You saw in earlier
training that these objects allow you to give your button a different look. In this lesson,
we will stick with the traditional look of the Button object.
2. On the File menu, select New Button Trigger or on the Tool Bar, click the New Button
Trigger button to create a new button trigger. Set the Trigger Name to EmpReports,
leave the Category set to User, and set the Button Caption to Employee Reports.
The Auto Execute button should be selected when you have a button on a screen that
performs an action that you would like to have fired off whenever that screen is displayed
(recalculating totals on a screen, for example). We aren’t doing that in our example, so
we will leave it unselected.
3. On the Actions tab, add a Run Document action. Open the Detail for this action. Click
the popup button on the Document Name field to display a list of the available
documents. In the Attendance category, select the Attendance Balances by Account
report. Set the Group Type to Current Record. Set the Auto-Destination to Viewer.
This will cause a document to be created for the employee being edited. If you wanted,
you could produce documents for each employee in the current group, or you could defer
to the query inside the document itself. Those options are relevant here.
4. Close the Run Document screen, saving your changes. Add another Run Document
action. This time, select the Salary History by Employee report from the Compensation
category. Again, set the Group Type to Current Record. Set the Auto-Destination to
Viewer. Close the Run Document screen, saving your changes. Close the Button
Triggers screen.
To test our trigger, we need to place the button on a custom screen. We’ll create a screen
quickly since we are already experts.
5. On the Tools menu, select Custom Screens. Create a new custom screen. Name the
screen New Personal. On the File menu, select Append Screen and append the
Personal screen to your custom screen. Scroll to the bottom of the list of objects and
insert a Button object after the last Screen object. In the Object Name field, select the
EmpReports button that we just created. The caption should default to Employee
Reports. Delete the Communication screen object. Use preview mode to move the
button under the other buttons and size it as needed. Use the techniques you have learned
to make any necessary adjustments. Close preview mode, saving your changes. Close the
Custom Screens screen, saving your changes.
Now we need to put the screen on a workflow.
6. On the Tools menu, select Workflows. Select the Standard - Employee workflow and
click the Screens tab. Use the Screen Name popup to change the first screen to the New
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Personal screen we just created. You can leave the rest of the workflow as it is. Close the
Workflows screen, saving your changes.
7. Open Donald Stern’s record.
The screen you should see is the screen we just created. You should see an Employee
Reports button.
8. Click on the Employee Reports button now.
The first report in our action list, Attendance Balances by Account, is run and displayed
in the Document Viewer. It will show the balances for Donald Stern and that is all.
9. Close the Document Viewer and the next report will automatically run and then be
displayed in the Document Viewer. This report will show the salary history for Donald
Stern. Close the Document Viewer.
Now there is an example of how to run reports for the current record on demand from a
button. Can we make it better? Of course. One obvious improvement would be to put the
two reports into a cluster report. Then, the Document Viewer would be displayed only
once and it would be much easier to view and print the documents. We won’t
demonstrate this feature now, but you know how to do it from prior lessons.
10. Close Donald Stern’s record.
11. Continue with the next tutorial.
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Tutorial 3.2 – Email a Document On Demand
Wouldn’t it be great to be able to click a button and have an email sent to an employee with a
special document attached? It would be great and you are now going to learn how to do it.
1. On the Tools menu, select Button Triggers, and then select the EmpReports trigger. On
the Actions tab, delete the two actions we added in the last tutorial. Create a new Send
Email action and open the Detail for it.
Whenever we click this button, we want the email to be sent to the address of the current
record.
2. So, set the To Address Type to Field Substitution.
3. In the To field, use the popup button to select Email, which is the employee’s main email
address.
This means that when the button is clicked, the email address for the current record will
be derived and the email will be sent to that address.
4. Click the Message tab.
We won’t be using an Email Definition in our example.
5. In the From Address Type field, select Address Book.
We will set the From field to Timothy Carpenter’s email as we have done before.
6. Click the Address Book button.
The Email Source screen is displayed.
7. In the list of source types on the left, select HR User and then select Timothy Carpenter
in the list of names on the right.
8. Set the Subject to I-9 Form Enclosed.
9. In the Text field, enter the following:
Please print the attached form. Complete the form using the included instructions
and return the form with the requested attachments to Human Resources. If you
have any questions, please contact HR at 345-9100.
10. Click the Attachments tab.
11. In the Attachment 1 field, click the popup button to display a list of email attachments,
which were created using the Email Attachments process. Select the I-9.PDF file.
People-Trak uses the Email Attachments process as a means of granting you control over
the documents that can be attached to emails. Only those documents specified in that
process can be attached to an email that is going to be sent when a trigger is executed
because the attachment needs to be in a centralized place. We already specified the I9.PDF file for you.
If you want the attachment encrypted when sent, you would select the Encrypt 1 check
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box. You have already seen how encryption works in the last lesson, so we won’t cover
that again.
12. Close the Send Email screen, saving your changes. Close the Button Triggers screen.
Let’s go try this.
13. Open Donald Stern’s record. Click on the Employee Reports button. An email
simulation is displayed.
You can see from the simulation that an email was generated for Donald Stern and that
the I-9 document was attached.
14. Click OK to close the email simulation.
15. Close Donald Stern’s record.
The Send Email action allows you to send two individual attachments as well as the
report attachment we learned about in the last lesson. You can use all three at the same
time, if you wish. If you have a need to attach more documents, you can always create a
multi-document PDF and send them all at once.
16. Continue with the next tutorial.
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Tutorial 3.3 – Populate Multiple Fields with a Single Click
There are times when you may find that you are keying the same values for every new
employee. While you may not wish to be “super person” who can “leap over tall buildings in
a single bound”, perhaps you would just like to save a little time. In this tutorial, we’ll show
you how to populate multiple fields with a single click.
1. On the Tools menu, select Button Triggers and create a new button trigger. Set the
Trigger Name to Stuff. Set the Button Caption to Stuff Data.
2. Click the Actions tab.
We are going to create a series of Update Field actions. We’ll start with the first one now.
3. Add a new Update Field action, and open the Detail for it. Set the Field Name to
Payroll Company. Set New Value Type to Value and New Value to ZTI.
We do not need to specify anything in the other fields on the Update Field screen because
they are applicable to grid fields and we are going to be using single fields. You will
learn more about these other fields on the Update Field screen in a later lesson.
4. Add five more Update Field actions with the settings shown below:
Field Name
New Value Type
New Value

City
Value
San Diego

Field Name
New Value Type
New Value

State
Value
CA

Field Name
New Value Type
New Value

Employment Status
Value
Full-Time

Field Name
New Value Type
New Value

Secondary Status
Value
Regular

Field Name
New Value Type
New Value

I-9 Document 1
Value
Driver’s License

5. Close the Button Triggers screen.
We need to update our custom screen to utilize this button trigger.
6. On the Tools menu, select Custom Screens. Select the screen named New Personal.
Locate the EmpReports button object added earlier. Change the object to use the Stuff
button we just created. Use preview mode to make any necessary adjustments. Close
preview mode, saving any changes. Close the Custom Screens screen, saving your
changes.
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This screen is already associated with the Standard - Employee workflow and the
changes we make are dynamic. So, all we need to do is create a record.
7. Click the New Employee shortcut.
The Create Employee screen is displayed with the Employee Source field set to Scratch.
8. Click Create to create a new employee from scratch.
9. Click the Stuff Data button. On the New Personal screen, the City, State, and Payroll
Company are set. On the Status screen, the Employment Status, Secondary Status,
and first I-9 Document are set. Delete the new record.
You can use buttons and Update Field actions to perform all types of data entry tasks.
You are limited only by what you wish to achieve.
10. This concludes this tutorial and lesson.
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